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Getting Started with Excel Integrated Reporting for Sage Line 50

Installing

Excel Integrated Reporting is installed along with Sage Line 50version 12, so if you have Line 50 v12
installed on your PC, you can start using the Excel Integrated Reporting feature straight away. If you're
using a networked version of Line 50 to access your accounts data from a server, you can use the
Excel Integrated Reporting feature from your computer to link to the same data. It's even possible to
use the Excel Integrated Reporting feature on a PC that does not have Line 50 version 12 installed.
For example, your Sales Director might want to produce reports based on the accounts data, but
doesn't need to install Line 50. A separate, stand-alone installation is provided for such requirements.

To install Excel Integrated Reporting on a computer that doesn’t use Line 50, insert your Line 50
Version 12 CD into your CD-ROM drive, select the 'Sage Remote Applications' option from the
installation menu and choose 'Install Excel Integrated Reporting'. Follow the instructions that appear
on your screen and the automatic installer will do the rest for you.

Getting Started

To start using Excel Integrated Reporting, you need to establish the link between Excel and your Line
50 data. This section shows you how to set up the link: try this now, so that you can start to explore the
Sage Functions and Data Ranges when we look at them in the following sections.

Start Microsoft® Excel and choose Select Company from the Sage menu. Or, if you prefer to use a
toolbar, there's a new Sage Integrated Reporting toolbar included in Excel. To see this, open Toolbars
from the View menu and select Sage Integrated Reporting. You'll see that the toolbar also contains the
Select Company option. When you click Select Company, a logon window appears:
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If Line 50 is installed on this computer, Excel Integrated Reporting locates the path used for the latest
installation. If your data is also held on this machine’s local drive, the Logon window’s 'Data path' box
displays the path to the data directory.

If you have more than one company set up in Line 50 and you want to select a different company, click

‘Look for another company' and use the 'Select the directory that contains your accounts' window to
locate the data of the company you want to use:

Lateral Solutions is the trading name of Lateral Corporate Solutions Limited

New Burlington House, 1075 Finchley Road, London, NW11 OPU Company No. 8164090. Registered in Enland & Wales.



LATERAL
' SOLUTIONS

the business of efficiency

Select the divectory that contains your Soco e |
Lack jn: | /3 ACC0 AT =] = & ¢ B

Dimnagiss

THs=i

Flepame:  [SETURDTA dpen |

Fiet e [Company dala fie |SET LP.174) Bl Lol

When you’ve located the ACCDATA folder containing the data files of the company you want to link to,
open it and select the SETUP.DTAfile. Click Open to insert the path into the 'Data path' box in the
Logon window. For example, if you link to the data within the COMPANY.001 folder as shown, the
'‘Data path' box displays C:\ProgramFiles\Sage\Accounts\Company.001\ACCDATA\.If you’re using
Excel Integrated Reporting on a network client computer, or on a machine that does not have Line 50
installed, you'll need to use the 'Look for another company' button to locate your data, as described
above.

In the Logon window, enter your logon name and password in the boxes provided. Use the 'Company’
and 'Chart of Accounts' dropdowns to choose the company information you want to report on, then
click OK.

Note: When you first install Excel Integrated Reporting, the only Line50 user who can access the
feature is MANAGER. You must logon using the MANAGER user name and its associated password
(by default, for example if you have just installed Line 50 for the first time, this user name has no
password). If you want others to have access to Excel Integrated Reporting, you must create a user
name for each person and assign full access to this feature.

TIP: If you intend to use the Sage Excel features on a regular basis, you will benefit from creating one
or more users in Sage Line 50 specifically for this purpose. This means that all your Sage Line 50
users will be able to continue using Line 50, even while other people in your company are using the
Sage Excel features. For full details on how to create users and assign access rights, refer to your Line
50 User Guide or online Help.

When you save your worksheet, Excel stores the link to your Line 50 data, so that you don't have to
specify where your data is held each time you open the worksheet.

Now that you've set up the link between the worksheet and your Sage Line 50 data, you can start to
use the Sage Functions and Data Ranges described in the next sections. Follow the examples
provided to familiarise yourself with the features and get an idea of what you can do; we'll start by
looking at Sage Functions.
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Sage Functions

Excel users will be familiar with its native functions, such as sum(),average() and count(). Sage
Functions work in exactly the same way as Excel functions, but they operate on your Sage accounts
data as well as information in your Excel worksheet.

Sage Functions can be divided into two main groups:

o List functions - these can be used to place drop-down selectors on your worksheet.
= Value functions - these return text or number values to your worksheet.

The best way to understand the Sage Functions is to use them, so we’ll produce a simple customer
look-up worksheet that you can use to retrieve customer account information from Line 50.First, we'll
insert a Sage list function that provides a drop-down list of your customer accounts. Start by selecting
cell Al in the worksheet and typing a label for the customer account reference, such as ‘Customer:'.
Now select cell B1 and click the 'Paste Function' button(fx) from the toolbar, or choose Function from
the Insert menu.

The 'Paste Function' window appears:
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Find and select the 'Sage Accounts' function category in the list - this could be towards the bottom of
the category list, so you may have to scroll down. When you select the 'Sage Accounts' category, the
right-hand 'Function name' pane displays all the available Sage Functions. Select SgAccCustomerList
- you'll see that a description of the function appears at the bottom of the Paste Function window to
help you choose the function you need.

Click OK and the Formula Palette appears:
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Click OK again and cell B1 in your worksheet now displays the Customer List drop-down:
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Click the drop-down button and you will see a list of all the customer accounts that exist in your Sage
Line 50 data. Select a different customer account - you'll notice that as you select an entry in the list,
the contents of cell B1 are refreshed.

Next, we'll add a value function to retrieve the name of the customer account currently selected in cell
B1. Click in cell A2 and type a label for the customer name, then move into cell B2. To insert the value
function, just click fx again, or choose Function from the Insert menu. This time, select the
SgAccCustomerName function from the list of Sage Accounts functions.

When the Formula Palette appears, you need to tell the function where to find the customer account
reference. Simply type B1 in the argument box, or click on the B1 cell. Click OK to insert the function
into the worksheet.

TIP: If you want to click on a cell and the Formula Palette is covering the one you need to select, you
can move the palette. Click and hold down the left mouse button anywhere on the palette and drag it
away from the cell you need by moving the mouse and then releasing the left mouse button.

You'll see that cell B2 now contains the name of the customer account that appears in B1:
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We'll finish the customer look-up worksheet by adding two more value functions to retrieve the
customer's telephone number and credit limit.

Type labels in cells A3 and A4, such as 'Phone:' and 'Credit Limit:’. Now insert the
SgAccCustomerPhone function into cell B3 and theSgAccCustomerCreditLimit function into cell B4, as
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you did before. Remember to type the cell reference for the cell containing your customer account
drop-down when adding these new functions. Your worksheet should now look something like this:
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Try changing the customer reference in cell B1 by clicking the dropdown list. When you select a
different customer reference, you'll see that the name, phone and credit limit information automatically
updates. By creating a simple worksheet using just one list function and three value functions, we can
quickly look up customer information held in Sage Line 50, directly from Excel! Try some of the other
Sage Functions to become familiar with the information available. You'll notice that some of the
functions require more than one argument, for exampleSgAccCustomerAgedBalance. In these cases,
simply enter the criteria you want Excel to return the result for, for example the Year and Period.
Sage Functions provide a simple way to access Line 50 data from Excel, but you may be wondering
whether there's an easy way to get larger amounts of data from Line 50 into Excel. It's time to move
onto Sage Data Ranges.

Sage Data Ranges

Sage Data Ranges provide an easy-to-use way of getting large amounts of data from Sage Line 50
into your Excel worksheet, including standard Sage reports or your own custom reports. Some Sage
Data Ranges invite you to enter parameters, or criteria, so that you can specify exactly what data you
want to appear. For example, if you choose to insert the ‘Nominal Account Totals by Month’ data
range, you can specify the range of nominal codes for which you want Excel to return your data.

Let's add the 'Top Customers by Sales' data range to the worksheet you've been working on.

To insert a Sage Data Range, start by selecting the worksheet cell you want the range to start from.
Select cell A6 in your worksheet. Next, select Sage from the menu bar. From the drop-down menu,
choose 'Insert Sage Data Range":
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Now, select the range you want to include in your workbook from theist. In this example, select
Customer Orders in the list and click Insert.

TIP: Select 'Embed Sage Report into Workbook' if you are going to send the finished Excel worksheet
to someone who does not have the selected Sage Data Range (report file). The report file is attached
to the worksheet providing a full working copy of the report.

This Sage Data Range requires you to enter parameters, so the Criteria window appears:
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Simply enter the criteria you want to use, and click OK when you are ready to continue.
Excel inserts the 'Customer Orders' data range, starting at the currently selected cell. Your worksheet
should now look something like this:
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By simply selecting a Sage Data Range from the list, you've inserted a summary report of your
customers’ orders into your worksheet. If you want to view the details of any of the customers listed,
select their account reference using the drop-down in cell B1. The functions you entered earlier display
the customer’s full account name, phone number and credit limit.

TIP: You can modify the criteria of a data range such as the selected date or transaction range. To do
this, select the data range and rightclick,choose Sage from the menu option, then select 'Sage Data
Range Properties'. Click Modify Criteria on the displayed 'Sage Data Range Properties' window to
change the data range’s criteria. Sage Data Ranges link dynamically to your Line 50 data: if your Sage
data changes, you might want your workbook to reflect those changes, or you might not.

You can control how your workbook responds to changes in your Sage accounts data using the
Refresh feature. You can refresh:

= The whole workbook. To do this click Refresh on the Sage Integrated Reporting toolbar. You can
also select the Sage menu and choose 'Refresh Sage Data'.

> A single data range within the workbook. To do this select the data range, right-click using the
mouse and choose 'Sage' from the menu options, then select 'Refresh Sage Data Range’. If you
choose not to refresh the Sage data in your workbook, it will remain unchanged, regardless of any
amendments you make in Line50.When you open a saved workbook that contains Sage Data Ranges,

Excel displays a message:
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Again, you can choose to refresh the data ranges in your workbook by clicking Yes, or to leave the
data ranges unchanged by clicking No. You’ve seen how Sage Functions and Sage Data Ranges can
help you to access your Line 50 data. Let’s look now at the Sample Workbooks included with Excel
Integrated Reporting, to see what type of results you can produce by combining the functions and data
ranges with Excel’s native functionality.

Sample Workbooks

Excel Integrated Reporting for Sage Line 50 comes complete with a set of sample workbooks. These
illustrate the type of results you can produce by combining Sage Data Ranges and Sage Functions
with Excel’s native functionality. The sample workbooks included are:

» Key Performance Indicators
- Balance Sheet

- Profit and Loss

- Trial Balance

- Sales Analysis

The sample workbooks are installed in the form of Excel templates, allowing you to open the files to
view, or to use them as the basis for your own customized workbooks.

To open a workbook template, open Excel’s File menu and choose New. From the New window, click
the Sage tab: Select the workbook template you want to view or edit, for example'KPIs.xlt' and click
OK.

Note: The sample workbook templates install into Excel’s default Templates directory, within a new
folder called 'Sage'. Each individual Windows user name has its own Templates folder. For example,
the user ‘john. smith' might access Excel templates from C:\Documentsand Settings\john.
smith\Application Data\Microsoft\Templates. If more than one user needs to access the templates on a
single machine, you must copy the 'Sage' folder into the Templates directory for each user. Because
the sample workbooks contain Sage data, a confirmation message appears, prompting you to refresh
the data. Click Yes to refresh the data, or click No to view the sample data as it currently appears.

The sample workbooks demonstrate the type of results you can achieve using the Excel Integrated
Reporting technology. The information they display is based on the data contained within Line50’s
Demonstration company, 'Stationery & Computer Mart (UK)'. To apply any of the workbooks to your
own business, you may need to modify the nominal report categories that the workbooks are built on
using the appropriate queries and data ranges.

For example, you might have a different set of 'key performance indicators' than those shown in the
sample Key Performance Indicators workbook that you would like to report on, perhaps using other
parts of your accounts data and using alternative table and simple chart formats. You might even
choose to employ some of Excel’s more advanced native technologies, such as Charting and
PivotTables.

If you're already familiar with extracting data from other Sage applications or third-party programs into

Excel, you could combine this with your Sage accounts data to produce your own consolidated reports
from multiple data sources.
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Key Performance Indicators Workbook

The Key Performance Indicators (KPI) workbook is an accessible summary of real-time management
information. It takes headline information from your accounts and presents it in a format that is
accessible, portable and easy to understand.

You can use the KPI workbook illustratively, as an 'at-a-glance' guide, to share with others an
understanding of how the organisation is performing overall. Alternatively, you can use the workbook
diagnostically, as a tool to check and measure the 'vital signs' of the financial health of the
organisation.

The KPI workbook presents two types of key performance indicators in separate worksheets. Both
sheets use simple data ranges, functions, tables and charts.

< The Financial Indicators worksheet presents headline information and charts based on the financials
of the organisation. For example, you can view summaries and charts for the profit and loss accounts
and the total balances on each of your bank accounts:

» The Commercial Indicators worksheet presents headline information on some of the commercial
aspects of the organisation, showing, for example, the top five customers and suppliers, in order of
value, in tabular format and supplemented with pie charts:

In addition to the Financial Indicators and Commercial Indicators worksheets, the KPI workbook also
contains a Criteria worksheet that enables you to select a different financial period to view. Like all the
sample workbooks, the KPI workbook is based on the data in Line 50’'s Demonstration company, but
you can configure and extend it as you require to fit the needs of your organisation.

Balance Sheet Workbook

The Balance Sheet workbook provides you with a series of sample report layouts that you can use in
your business. The workbook is made up of six separate worksheets. The Criteria sheet enables you
to select a different financial period to view data for. The remaining worksheets display a number of
different Balance Sheet report formats for you to choose from:

- The Horizontal layout displays all your balance sheet information in a single view:

< The Line 50 worksheet replicates the existing Sage Line 50Balance Sheet report layout.
= The Vertical layout is similar to the Line 50 worksheet

» The Separated sheet keeps assets and liabilities clearly separated:

There is no "right" layout for you to use - the format you choose depends upon your business and on
how you want to represent its financial information on paper. As each worksheet is amendable, you
can use these sample layouts as a starting point to deliver customised balance sheets that exactly
match your business requirements.

Profit and Loss Workbook

Like the Balance Sheet workbook, this provides you with a series of sample Profit and Loss reports
that you can apply to your business. The workbook comprises four separate worksheets. The Criteria
sheet enables you to select a different financial period to view the information for. The remaining four
sheets provide a number of different Profit and Loss formats for you to choose from:
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= The Horizontal layout provides all your profit information in a single view:

» The Line 50 worksheet replicates the existing Sage Line 50Profit and Loss report layout.

- The Vertical format is similar to the Line 50 worksheet. Again, there is no "right" layout for you to use
- choose the one that fits your requirements. Use the sample Profit and Loss formats as a basis to
create your own report that is perfectly tailored to your own business’s needs.

Trial Balance Workbook

This workbook provides you with a series of sample Trial Balance reports and includes PivotTables to
illustrate the type of results you might achieve if you apply some of Excel's more advanced native
functionality. The workbook contains five separate worksheets and includes(together with the Criteria
sheet) the following different Trial Balance formats:

< The Simple Trial Balance uses PivotTable technology to present the total ledger balances in a
standard two-column debit and credit format, with grand totals and balance checking:

» The Monthly Trial Balance analyses the ledger balances into the brought forward balance, monthly
balances and carry forward balance, this time presenting debits and credits as negative and positive
values respectively.

< The Extended Trial Balance draws on the Simple Trial Balance and also provides an opportunity to
make adjustments to the ledger balances, to carry the combined figures through to summary Profit and
Loss and Balance Sheet accounts and make balancing entries on those accounts. As with all the
sample workbooks, select the layout that most closely relates to your business needs.

Sales Analysis Workbook

This workbook provides you with several sample configurable Sales Analysis reports that you can use
within your business from day one. As in the Trial Balance workbook, the worksheets contained within
the workbook use PivotTables and Pivot Charts.

The workbook contains eight worksheets. Together with the Criteria sheet and the Data sheet, which
displays the raw data from which the other worksheets are compiled, it contains the following Sales
Analysis formats:

» The Sales Value by Customer worksheet provides an analysis of customer sales by value per
month:

< This information is also illustrated in the form of a chart in the Sales Value by Customer Chart
worksheet

< The Sales % Value by Customer worksheet provides a similar analysis, by percentage:

- The Sales Value by Category worksheet provides an analysis of the top ten sales by value, per
month, per category

- The Sales Value by Department provides a similar analysis by department:

< The Sales Value by Product worksheet provides an analysis of sales by product category and
product per month: As with each of the sample workbooks, the layout you choose depends on your
business needs and the information you want to display.
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